DRUPAL TRAINING GUIDE
Accessing the Website
Barton Website URL: www.bartonccc.edu 
(Please refrain from using www.bartoncougars.com for any links as it was a temporary web address during the production of the new website.)
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Editing Webpages and Content in Drupal
Logging In and First Time Steps
1. Go to www.bartonccc.edu/user to login. All webeditors should have their own login using the prefix to their Barton email as a username and “barton” as the password for first time logins (these passwords can be changed by selecting the “Edit” tab on your profile page after you’ve logged in). Please note: if you haven’t met with PR to get training, your username will not be set up yet. Please contact Samantha Stueder (ext. 354) to set up training.
[image: ]
2. Webeditors WILL NOT need to worry about the black and gray admin panel that appears after login. Simply ignore this bar, as it is used for back end content access by administrators.
[image: ]
3. Once an editor is logged in, the “View” and “Edit” tabs will appear above the editable content on any page within the site, with the exception of the homepage. This is where webeditors will change their content (similar to the “Last Modified” link on OMNI, however, these tabs only appear once a webeditor is logged in) 
· On the “Edit” page, webeditors can toggle back to “View” by clicking the tab in the top right corner – ONLY if there are no changes! If you click the “View” tab to return to the page you’re trying to edit without saving your changes, they will be lost. 
[image: ]
The View, Edit and Revisions tabs will be viewable in each of the tabs. In the Edit and Revisions tabs, it is located in the upper right hand corner.









Overview of Editable Regions
To edit YOUR webpage, simply select the “Edit” tab. Once you’re in the Edit Page view, you’ll notice the following options for areas to edit:
· Title: This will change the title of the page as seen in the Admin Dashboard, but NOT in the navigation. (Note: if you change the title of a page after it is created, you will also need to edit the page name in the Menu Settings section in order to change how it appears in the navigation) Please do not change any page names without first talking to the webmaster.
· Body: 
i. Enter all content here, including text, links, in-line images, etc. (See “Inserting Content” below for text, image and video embedding options)
ii. All images included in the body should be 300x200 pixels for a horizontal image, or 200x300 for a vertical image. See “Inserting Images” for full instructions. 
iii. The Body section uses a WYSIWYG editor for editing text styles, adding links, etc. Hovering over each icon will provide a tooltip as to the button’s action. (See WYSIWYG Editors section below for more details)
iv. Please refer to Content Guidelines to follow all established styles, including font size and color, bolding/underlining text, and general styling policies.
v. The Text Format option has been set to “Filitered HTML” as a default – if you notice that your WYSIWYG editor isn’t appearing, check to make sure this option is selected.
· Gallery: 
i. The Gallery refers to the header images on each page. Only 1st and 2nd level templates will show the header images. 
ii. These images have been edited and cropped to specifically fit this area. If you would like to update your header image, please contact the webmaster.
· Page Template:
i. Page templates correlate to the level that the content is on. For example, all of the main navigation items (Admission, Degrees & Programs, etc.) are Level 1 templates. The first items in each left side navigation menu are Level 2 templates. The items that expand out in the left side navigation menus are Level 3 templates. 
ii. These templates should already be established for all of the pages on the website and as pages are built by the webmaster.
· Announcements and Video Code:
i. These two blocks are only available on Level 1 templates, and sometimes Level 2 templates. 
ii. These blocks should be established by the webmaster, and then can be updated by that page’s webeditor.
· Contact Us:
i. Add in contact information for the respective department/office for the page. 
ii. Contact info should be listed as closely to the following format as possible: 
1. Office or Name
2. If a name is listed, then list that person’s title
3. Location on campus
4. Phone number(s)
5. Email Address
6. Hours of Operation, if necessary
7. Days 
8. Hours
· Menu Settings:
i. All menu settings will be established as pages are created by webmaster. Each page should have a Description, added by webeditors, to describe the content on that page.
· Revision Information:
i. After you make any edits to a page, you will want to check the “Create new revision” box under the “Revision Information” tab. This will allow us to look over previous edits/changes on pages, as well as revert if necessary. Similar to OMNI, simply add a message about what you changed and sign with your username.
· HIT SAVE! Once you save the page, it will take you back to the “View” tab, or the regular page view.






Inserting Content
Inserting Images: Webeditors may insert images by use of Barton’s Flickr account, meaning any image on Flickr is available to be used on the web
1. Visit Barton’s Flickr account by clicking the Flickr logo in the website’s header, or click here: https://www.flickr.com/photos/bartoncc_pr/sets/ 
2. Images are organized by “Albums” or events, so find the event you’re looking for and open the album.
3. Once you’ve found the image you want to use, click to open it to full screen
4. [bookmark: _GoBack]Using the icon with the three dots, select “Download/All Sizes” (when the pop up comes up, click “All Sizes” again)
5. Choose the “Small – 320” sized image (it should open this size to view)
6. Right click and select “Copy Image URL” (browsers may differ with the wording, others may use “Copy Image Location”)
7. In the Edit view on the website, select the Image icon and paste the image’s URL into the first line, “URL”
a. Insert description of image into “Alternative Text” – this will help with ADA requirements and searchability
b. The width and height of the image should automatically pull in, you will need to change the width to 300 for horizontal images (typically the height will be around 200), or 200x300 for vertical images. *Make sure the lock icon is locked to keep the aspect ratio the same when sizing.
c. Under HSpace, enter “10”
d. Under VSpace, enter “5”
e. Select desired alignment (either right or left – standard used is right when aligning with a paragraph of text)
f. To link the image, select the link tab and paste the URL for the link, and also set the Target to “New Window”
8. Images can be dragged to a different position on the page by clicking, dragging and dropping where the cursor aligns
9. Images that would otherwise not be on Flickr will be uploaded to the Website Imagery set: http://www.flickr.com/photos/bartoncc_pr/sets/72157638523095215/ 
10.  Any personal images will need to be sent to PR and approved, and then will be added to Flickr by PR
Inserting Documents: Website documents for both the public and internal websites are available online at docs.bartonccc.edu. Public website files are organized in folders resembling the website, i.e. in one of the five navigation folders (Admissions, Degrees & Programs, Student Services, Community and About Barton). Webeditors will save documents in the same way to the T: drive and use FileZilla to upload these files. (For FileZilla setup or training, please refer to the FileZilla Setup document, or contact the webmaster)
To link to documents:
1. Visit docs.bartonccc.edu and navigate to the file you want to link
2. You can link to the document two different ways:
a. Right click on the link and select “Copy Link Location” (this verbiage may vary slightly between browsers)
b. Open the document and copy the full URL path from the URL bar
3. In the Edit window of your page in the Barton website, open the Hyperlink icon and paste the URL into the “URL” field 
4. Select the Target tab and change the Target to “New Window” 
















WYSIWYG Editors
OMNI (Old CMS/Website) WYSIWYG Editor
[image: ]
Drupal (New CMS/Website) WYSIWYG Editor
[image: ]
Hover over each of the icons for the icon title. 
Similar Icons/Features:
· Spell Check
· Special Characters
· Insert Image
· Hyperlink
· General Text Styles and alignment
Headings Dropdown and Styles:
· Normal
[image: ]
· Heading 1
[image: ]
· Heading 2
[image: ]
· Heading 3
[image: ]
· Heading 4
[image: ]
· Heading 5
[image: ]
· Heading 6
[image: ]











Content Guidelines for Web Editors
Barton Branding
Please refer to the Brand Guide 
Image Sizes and Placement
· Images placed in the text should be sized as closely to 300x200 (Horizontal) or 200x300 (Vertical) as possible. Any Large or Small header images must be sized and placed by the webmaster, and may be done by request.
· Images should be aligned aesthetically with text or bulleted lists 
Links: URLs, Phone Numbers and Emails
· There are two options when including links in the content of a page; the first is to link the text and the second is to provide the URL.
· To link the text, highlight the phrase that would like to link. You may use the format “Barton Athletics website” or “click here to visit the Barton Athletics website”
· When listing a URL in the text, use a short version of the URL and include the full link in the link manager, instead of pasting the full link into the text. This will keep the text looking clean, but will still allow a user to click to the specific page you are trying to link to. 
· For example: if you wanted to link to the Barton Athletics website, you would provide a link that looks like www.bartonsports.com instead of the actual URL, http://www.bartonsports.com/landing/index. 
· All URLs that lead to an external website (a website that is not Barton-related), should open in a new tab or window. When linking to another Barton page, these links do not need to open in a new tab or window.
· Documents should always open in a new tab or window as well.
· Phone numbers should be listed with the area code in parenthesis followed by the three prefix numbers, a dash and the last four numbers
· Correct: (123) 456-7890
· Incorrect: 123-456-7890
· Additionally, phone numbers should be linked so that they may be utilized when a user is on a phone or tablet (using tel: ####### in the Hyperlink box)
Link and Character Styles
· The link and character styles have been established in the code and are not to be changed. This includes text color and font style, link color and style, headers, etc.
Tooltips
· Add a tooltip and description for any links or images added, including emails, internal and external URLs, phone numbers, graphics, etc. 
· For emails and phone numbers, include the name of the person or department in the following format: “Email Public Relations” or “Call Admissions”
Page Descriptions
· Make sure the page description at the bottom of each page has a sentence describing the page’s content, similar to a Summary-type page
Saving Procedures
· Webeditors must hit “Save” at the bottom of the page to save their work. Once you hit save, the page will open up with your saved changes. If you’ve embedded any code (i.e. video, etc.), you may have to refresh your page after saving. *Always save a new revision with details and your name!
General Text Guidelines
· Do not bold or underline any text within a paragraph to emphasize the text. Bolding has been reserved for headlines and sub-headers, and underline will indicate a link. 
General Guidelines
· Do not copy and paste content from another page or website, link to that page or website instead. Common content will not be used. 
· 
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Getting Started

You are only a few quick steps away from becoming a Barton Cougar!
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